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SMARTEAM - CATIA Integration
Objectives of the course
At the end of this course you will be able to store and retrieve the 
CATIA V5 documents and also analyze the links between them in 
SMARTEAM, during the entire lifecycle of the Product.

Targeted audience
CATIA V5 Users

Prerequisites
CATIA Basics, SMARTEAM - Editor User course

1.0 day
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Introduction to CATIA Integration
You will become familiar with the concepts used in SMARTEAM - CATIA 
Integration.
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SMARTEAM Industry-driven PLM Solutions

SMARTEAM has tight integrations with various authoring tools among the CAD legacy systems   
which makes it attractive to design-centric organizations. 
By efficiently consolidating product data, facilitating data access and exchange and optimizing 
the processes to promote collaboration and reuse, SMARTEAM drives value from the earliest 
stage of product development.
In the coming chapter you will learn more about the CATIA Integration which is one of the more 
advanced one.

The capture, management and 
reuse of product IP through 
embedded, robust multi-CAx
integrations, empowered with 
comprehensive search and 
collaboration functionality
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What is SMARTEAM - CATIA Integration

Product knowledge Capture
Maximizing product and knowledge re-use
Remove Redundant activities
Capture product knowledge

Collaboration
Real time co-design collaboration through the vault
Local team collaboration through shared 
workspaces.
Distributed world wide product design 
collaboration through the vault
PLM on demand inside and outside the office.

Concurrent multi-disciplinary product optimization
FEM Analysis
Virtual simulations
Manufacturing
Technical publications

The SMARTEAM - CATIA integration (CAI) is the cornerstone of V5 Concurrent Engineering, 
enabling all Engineering disciplines to collaborate on product design, optimization and lifecycle 
management in an easy, dynamic and secured environment.

Here is what SMARTEAM's V5 PLM solutions can deliver around CAI to ensure that right users have 
the right information at the right time:
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The SMARTEAM - CATIA Integration Menu (1/2)

With the SMARTEAM-CATIA license installed and configured, you can connect to the 
SMARTEAM database as indicated below:

From the ‘SmarTeam’
menu, select Connect. OR

In the SMARTEAM 
toolbar, click on the 
Connect icon.

Enter User Name and Password in the 
‘SmarTeam User Login’ dialog box.

The Connect icon is 
disabled, and the 
SMARTEAM - CATIA 
Integration functions 
are activated.
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The SMARTEAM - CATIA Integration Menu (2/2)

Launch SMARTEAM - Editor

Indicates where the current 
document is used

Store data in the database

Connect to the database

Disconnect from the database

Look for a component 
stored in the database

Locate the active document of your 
CATIA session in the database 

Lifecycle management

‘SmarTeam’ menu in CATIA V5
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Catalogs Knowledge

Electrical

DMU review and technical documentation
Electrical
Manufacturing
Product Knowledge Templates
Analysis 
Drawings
Catalogs
Equipment & System
Assembly Design and product structure
Mold Tooling and Core&Cavity
DELMIA simulation
Weld design
Sheetmetal design
Knowledge Expert

NC

2D
3D

Analysis

Power of SMARTEAM - CATIA Integration

SMARTEAM - CATIA integration intuitively supports multi-discipline concurrent engineering.
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Saving CATIA V5 Documents
You will discover the methods to save CATIA objects in SMARTEAM.
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SMARTEAM - CATIA Integration Settings

The recommended settings for using SMARTEAM with CATIA can be put in place through 
Tools > Options > Document tab.

Set ‘SmarTeam’ as the allowed and 
current Document Environment.

Set ‘SmarTeam’ in the active state 
document localization by selecting 
Yes, and as the first priority using 
the Up button. Deactivate other 
options in the list as indicated in 
the adjoining screenshot and 
maintain the sequence with the Up 
and Down buttons.
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About Saving Objects

CATIA V5 Interface is enriched by a SMARTEAM menu and a toolbar. You will find there all 
the needed commands.
These commands allow you to rapidly save CATIA V5 documents in SMARTEAM and to act 
on them.

‘SmarTeam’ menu in CATIA V5

Save Commands

SMARTEAM Toolbar in CATIA V5

Save icon
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Saving a Document (1/3)

The SMARTEAM integrated menu provides two methods for saving CATIA documents:
Save: Saves the document into the SMARTEAM database. When a save is executed for the 
first time on a CATIA object the Project Manager and the Profile card (based on whether the 
Batch mode save option is selected or not) are displayed. Forthcoming saves do not display 
this panels.

Select Save from the 
‘SmarTeam’ menu.

The system updates the 
objects in the database.

Click on Save icon 
in the SMARTEAM 
toolbar.

OR
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Saving a Document (2/3)

Click to choose the project 
and the parent folder of the 
document.

Select ‘Save As…’ from 
the ‘SmarTeam’ menu.

Check or Uncheck to 
choose the adapted option.

The object will be saved as a 
child in the selected folder 
under the selected project.

Save As: Saves the document into the SMARTEAM database and lets you define the project 
and the parent folder for the document every time the command is executed. Thus generating 
new Document ID each time. 
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Saving a Document (3/3)

A Profile Card is displayed when the document has not already been saved in case of a 
normal SMARTEAM Save operation with the Batch Mode Save option unchecked. 
Enter a name for the part in Description Attribute.
In the Details tab, you can name the file. If you do not, the document ID will be automatically 
set as file name.

Desktop icon

Profile Card

Product Structure is 
displayed in the 
Documents tree

A SMARTEAM documents window is automatically displayed 
showing that the new document has been added to the database.
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Batch Mode Save

Check or uncheck of the Batch Mode Save gives you choice of displaying or not displaying the 
Object Attributes panel for each component during an Assembly save
This method allows you to save large assemblies in a shorter time.
Each component is saved in the database with a unique SMARTEAM ID number.

Click on Batch Mode 
Save to check or 
uncheck this option

Save icon

You can open a Profile Card for a component later for « update » after the 
save is completed. Information in the attribute fields can thus be modified. 
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How to Save an Assembly (1/2)

In the SMARTEAM - CATIA Integration hierarchy, all of the components of the Assembly 
are linked as components (children) of the Product.
This hierarchical link reflects the structure of the Assembly as designed in CATIA
The procedure is the same as adding a Part in SMARTEAM. 

Shown below is an Assembly loaded in CATIA V5 session. 1 Select the Batch Mode Save option. 
Object Attributes panel for each 
component will thus not be displayed 
during the save operation.

2 Click on the Save icon in SMARTEAM 
toolbar.
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Choose a project and a parent folder. 
The CATIA file name is displayed.

3 Click Save.4

How to Save an Assembly (2/2)

SMARTEAM Project Manager window

The inherent relationship between a Product 
and its components is automatically maintained 
and displayed in the SMARTEAM Documents 
window. 
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To avoid choosing the Project and Parent for every Save As operation, you can 
choose to customize your defaults options

How to Choose a Default Project and Parent

In SMARTEAM menu, select 
Tools / Default Link Settings

1
Select the Default Project2 Select the Default Parent3

You can locate the folder in 
SMARTEAM by clicking on 
Show button

4

After clicking on OK, when 
saving a document, the 
Default Project and Parent 
are automatically selected

Validate by “OK”5
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Bulk Loading

Whenever there are huge assemblies created in CATIA (locally saved) to be  saved into the 
SMARTEAM database, the Bulk Loading command comes very handy.
While executing Bulk Loading, the assembly is not opened in CATIA, thus saving a time 
required to load it into the CATIA session.
This command performs three operations at the same time – open, save and close and has 
the following advantages: 

The save operation is quick
Links between documents are kept
The attribute mapping mechanism is used during the save operation

Checking or Unchecking of the Batch Mode Save 
option has no effect during Bulk Loading.

Message indicates that the 
Bulk Loading is successful

CATIA files which are saved locally are selected in 
the panel for performing the Bulk Loading
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How to Use Bulk Loading (1/2)

From SMARTEAM menu, 
select Bulk Loading

Select the CATIA 
Document/ 
Documents in the 
directory on your 
computer.

1 2

The Bulk Loading command allows  you to save a large number of files in the database 
without much of user intervention.
While executing Bulk Loading, the assembly is not opened in CATIA, thus saving a time 
required to load it into the CATIA session. 

Choose the project and 
the parent folder for the 
document/ files.

3

Selecting a single root CATProduct in the directory while 
executing the Bulk Loading ensures that all the linked 
CATParts and Subassemblies present in the directory are 
saved in the SMARTEAM database. 

Click on Save4
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How to Use Bulk Loading (2/2)

A panel appears to confirm 
save in database successful. 
Click on “OK” to continue

5 The SMARTEAM Document window if open 
(minimized). All components previously selected for 
bulk loading, are displayed in the Documents tree
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Highlight in CATIA

CATIA-V5

SMARTEAM

By using this command you will be able to retrieve in CATIA, a document selected in the 
SMARTEAM Documents tree. The Highlight in CATIA command highlights the document in the 
CATIA session, assuming that the object selected in the SMARTEAM window is open in the 
CATIA session.
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Locating Active Document through the Desk Tree

In the Desk tree, information is displayed on all nodes corresponding to the loaded 
documents.
No information is displayed if the document is not loaded or not found. 

Locate the selected 
Document in SMARTEAM.

Profile card of the selected 
Document appears.
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Project Template

A template is a ready-to-use data structure. SMARTEAM - Editor provides numerous 
business template; and  each template is geared to a different environment, such as 
mechanical, maintenance and office. 
By providing business templates, SMARTEAM - Editor enables you to select a  template 
that is applicable to your environment and use it “as is”. You also have the option to 
customize these templates to suit your exact needs using the Data Model Designer, or to 
create a template from scratch and use it for your Project.
Using Project Templates help in bringing about uniformity in work along with reducing  
time and efforts. 
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How to Use a Project Template

Select the Project where all templates 
will be saved and validate “OK”

You can set a Project as Template Project and use the files linked to this Project as 
starter files.

Now, you are ready to create a 
document from a template

2From SMARTEAM menu, select 
Tools / Current Template Project1
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How to Use ‘New From’ from a Project Template

From SMARTEAM menu, 
select New From…

Select the file in the list that you want to 
make a new copy of and validate ‘OK’

New From functionality allows you to start a document from one already stored in the 
“Template Project” defined in the CATIA Integration.

A new copy  of the CATIA file is opened. 
You are ready to work with CATIA V5. 

1 2

In this case it is a blank drawing with a 
formatted Title block which is opened.
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SMARTEAM - CATIA Integration Settings
Saving CATIA documents in SMARTEAM
Highlight SMARTEAM objects in CATIA
Locating Active Document through the Desk Tree
Using Project Templates

To Sum Up

You have learned about
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Manipulating Object
You will learn to open objects by using Open command from CATIA V5.
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Displaying CATIA Document Status in Specification Tree

Each SMARTEAM object is displayed in CATIA V5 specification tree with an icon reflecting its 
state (i.e., New, Check In, Check Out, Release).

Connection to 
SMARTEAM 
is established

Product open 
without 
SMARTEAM 
connection

When there is no connection between CATIA-V5 and the SMARTEAM database, the SMARTEAM 
Lifecycle states for the CATIA objects in SMARTEAM are not indicated in the CATIA specification 
tree. The icon displayed is typically a page which has the top right side folded.
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Status List

Released, Not 
Latest

Obsolete

Released

Checked Out

Checked In, Not 
Latest, Dirty

Checked In,Dirty

Checked In, Not 
Latest

Checked In

New

Representative 
icon in CATIA

Lifecycle State
As shown in the list you can see all the lifecycle 
status types available in the specification tree from 
CATIA V5
The status of the SMARTEAM object will change 
during :

SMARTEAM save
SMARTEAM Lifecycle operations like Check in,  
Check out, Release and Obsolete
Usage of «Open for edit» command from 
SMARTEAM

The CATIA specification tree always reflect the lifecycle status of the object if a connection 
between SMARTEAM and CATIA is established.

Lifecycle states 
indicated in the 
CATIA spec tree. 

The status of the SMARTEAM object will 
not change during :

Open as « Read only » 
Open as « Temporary copy »
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Open Document in CATIA (1/2)

The first interface allows you to search 
objects through a query in SMARTEAM.

OR

File Open is generalized to give the ability to select a document from SMARTEAM instead of 
the file system location.
A SMARTEAM ‘Open Document’ panel is displayed by using the following commands only 
when the recommended settings good for using SMARTEAM with CATIA are got in place. 

The second interface allows you to search 
object directly in SMARTEAM.

File Open
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Open Document in CATIA (2/2)

By clicking on ‘SmarTeam’ icon, you 
re-open the pointed document panel.

OR

By clicking on the “Cancel” button the “Browser” toolbar is displayed, thanks to the CATIA 
Document Environment settings in Tools > Options.
The “Browser” toolbar gives you the options to re-open the documents from SMARTEAM or 
File location.
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How to Open an Object from CATIA V5

A SMARTEAM object pertinent to a CATIA class can be searched and opened in a CATIA 
session. Having launched CATIA and connected to SMARTEAM database

From the CATIA V5 menu, 
select File > Open…

Click on Open icon in 
the Standard toolbar.

OR

SMARTEAM Open document panel appears. 
Choose the class in dropdown list and click 
on Run.

1a

1b

2

Enter the value of the Description in 
the table3

The result displays in the same panel. 
Now, select the document and click on 
OK to open CATIA V5

4
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Performing File Operation

In the Documents window of SMARTEAM, you can select a Document and with the 
contextual menu, execute the following file operation options :

Open as read only

Open for edit  

Open to View the temporary copy. 
Based on the option chosen, the SMARTEAM object is opened in CATIA V5 session with 
Read or Write controls.

You can select any one 
option and click OK.

SMARTEAM Documents window
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Replace Component

Blade in use initially

The new (replacing) component is chosen from the objects stored in the database.
If the object type is not a CATPart or a CATProduct, a message is displayed and the operation 
is cancelled.
This function is accessible from the SMARTEAM menu or in the contextual menu of CATIA 
thanks to the generalized ‘file open’.

Blade after « Replace component » 

If there is more than one occurrence in the assembly, 
you can replace either the current one, or all of them.
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Replace with Selected Revision

Blade configuration 1 
(Revision a.o) 

If the design of a CATPart or a CATProduct has evolved across the Lifecycle of the CATPart or
CATProduct, « Replace with selected Revision » comes handy to swap the usage of Revisions 
(configurations) in the Assembly using
Below is indicated a case wherein Revision a.0 of the Blade is used in the Assembly. The 
design of the blade is still evolving until Revision a. 
You can select the CATPart in the CATIA spec tree and through the “SmarTeam” menu 
perform  Assembly Management> Replace with selected Revision. Selecting and validating 
use of Revision a in the SMARTEAM Revisions window to instantiate the new Blade 
configuration in to the Assembly.  

Blade configuration 2 
(Revision a)
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Using Catalogs
After this lesson, you will be able to create, populate a catalog and instantiate a 
component in an assembly. 
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What is a Catalog

A catalog is a file which provides you fast access and preview of CATIA Document, and    
features. It also classifies the documents or features with Chapters and Subchapters, and 
Keywords. The catalog file with its content are stored in the SMARTEAM database.
From CATIA Catalog Editor workbench, you can define a catalog and its structure (chapters, 
families, part families…) and you can query catalogs to find the required components.
From CATIA Catalog Browser panel, you can navigate through catalogs, instantiate catalog 
components, get a preview of any component. From several workbenches, Open Catalog 
icon is displayed and allows you to instantiate CATIA objects from the Catalog.

Catalog Editor Workbench

Catalog Browser icon
Open Catalog 
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Classification Benefits

Give engineers fast visibility to all components that meet their technical requirements
Avoid design iteration related to non appropriate components usages
Standardize product development
Reduce inventory write-off

Limit part proliferation
Reduce inventory write-off
It’s easier for an engineer to create a new part than find an existing one
Every new off the shelf part introduced into a corporation costs about $10,000

Reduce overall product cost
Reduce inventory write-off
Strategic sourcing

Early involvement of the procurement, manufacturing, EMS and components experts in the design 
process

Address engineering, manufacturing and supply chain issues at the earlier stages of product 
design with products that integrate design tools with components obsolescence and supply 
chain data.



Student Notes:

SMARTEAM - CATIA Integration

Copyright DASSAULT SYSTEMES ��

����������	��

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

Displaying Results of Catalog Save in SMARTEAM

In SMARTEAM, after saving, the system stores the catalog in the Documents class like a 
container of CATIA parts. If the Visual Settings are defined for the Links (red links), all parts 
display in the Documents Tree under the Catalog.

The view Links tab/ CATIA Links sub-tab is another mean to visualize the CATIA links. In the 
catalog case, SMARTEAM shows CATIA Reference links in this view

SMARTEAM Documents window

CATIA Catalog Editor



Student Notes:

SMARTEAM - CATIA Integration

Copyright DASSAULT SYSTEMES ��

����������	��

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

How to Use Catalog Components in CATIA V5 (1/2)

In CATIA V5, this methods allows you to instantiate a CATPart from the Catalog 
Browser panel.

Click on the Catalog Browser icon1 The Catalog Browser panel appears. 
Click on Browse another catalog icon

2

Automatically an intermediate panel 
appears to search a right catalog. Click 
on Run button to search all catalogs in 
SMARTEAM

A Product is opened in CATIA V5

3
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How to Use Catalog Components in CATIA V5 (2/2)

The result displays in the table. Select the adapted 
catalog and click on OK to load.

The Instantiate Component 
appears in the Specification Tree. 
Click OK.

6

4

The Catalog appears in the Catalog Browser 
panel. Navigate in the structure by double-
clicking and when the right part display, 
right-click on the part name. Choose 
‘Instantiate component…’ option. 

5
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Design Copy Tool
You will learn how to copy a product structure to another project. 
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About Design Copy

The Design Copy tool allows you to create a new SMARTEAM documents object structure by 
copying selected objects from an existing assembly.
This methods :

Duplicates meta-data
Duplicates files
Duplicates links
Changes the file references 
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How to Do the Design Copy (1/2)

The Product structure of which the Design copy is intended to be made, is opened in 
the SMARTEAM Documents window

Product Structure in the Document 
Brower Tree

1 Select the Document and with 
the contextual menu select « 
Design Copy »

Design Copy panel

Click on Options2

In Design Copy options, just before copying objects, you can 
change the Work directory to share files with another user or 
department.
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How to Do the Design Copy (2/2)

Design Copy options

Click Browse The shared work directory  is displayed in 
this panel. Select the intended folder and 
validate OK.

3

Design Copy panel

The SMARTEAM lifecycle state of the 
objects copied is ‘New’ immaterial of the 
state of the objects used for copy.

Click Copy5

4
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CATIA Links
You will see how to show and check CATIA links in SMARTEAM. 
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CATIA Links
This lesson will cover following topics:

About CATIA links
CATIA Links List
Displaying Link Impact
CATIA Drawing Links
CATIA Analysis Links
CATIA Process Links
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About CATIA Links 

SMARTEAM - Editor stores a large number of documents and types of relations between 
these documents. The documents created in several applications such as 
CATIA/DELMIA/ENOVIA V5.

The native SMARTEAM integration of CATIA link 
semantic enables dedicated behaviors on each type 
of link: 

Eased navigation  
Display links type (icon) 
Filter document relations by link type 
Improved Impact Analysis capabilities 

CATIA Results Links (RES)

CATIA Is composed of (IS)

CATIA Contextual Links (C)

CATIA Reference Links (REF)

CATIA Downstream 
Application Link (DA)

CATIA Design Table (DT)

CATIA Rule Base Link (RUL)

CATIA Design Link (D)

CATIA Product Link (P)

iconV5 Links

The nine ‘CATIA links’ managed by SMARTEAM
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CATIA Links List 1/4

Through the list below, you will discover all CATIA links exposed in SMARTEAM
Product Structure Link: This is the main link in SMARTEAM. It define the Bill Of Material 
structure.

CATProduct->CATProduct, CATProduct->CATPart, CATProduct->Internal Component…

Examples

Design Link: The ‘Design Link’ directly participates in 
the Design process to describe the relationship 
created by the designers between two parts. These 
links capture the important design intent information 
and are used extensively for impact analysis. 

Link to external parameters (formulas)…

Examples
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CATIA Links List 2/4

Downstream Application Link: The ‘Downstream Application Link’ corresponds to a link 
between a downstream application and the design data. It describes the relationship 
between a downstream application document (Drawing, NC,…) and a CATPart or
CATProduct

CATDrawing->CATProduct/CATPart, CATProcess->CATProduct/CATPart, CATAnalysis-
>CATProduct/CATPart

Examples

Design Table Link: The ‘Design Table Link’  
is a link between a CATIA document and its 
design table (excel or text file) and describes 
the relationship between them. 

Examples
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CATIA Links List 3/4

Examples

Rule Base Link: The ‘Rule Base Link’ 
describe a link between an instance of a 
rule base and its reference.

Result Link: The ‘Result Link’ corresponds to CATIA output links.
CATAnalysis->CATAnalysisResult, CATAnalysisComputation…
CATProcess->NC (aptsource, CATNCCode, tlp)
CATProcess documentation link (html)
Knowledge optimization link (CATIADocument->Excel/text)

Examples
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CATIA Links List 4/4

Reference Link: The ‘Reference Link’ includes all the CATIA links and describes the 
relationship between a CATPart or CATProduct with external documents (other than Excel).

CATDrawing->Image/OLE
CATProduct/CATPart->CATMaterial
CATProcess->NC Manufacturing Part (CATPart)
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Displaying Link Impact

Through this panel, you can display the 
links integration in the Documents tree.

From CATIA V5, after the Save command, the hierarchical structure is created in Super Class 
‘Documents’. SMARTEAM automatically generates the CATIA documents structure.
All kind of links generated in CATIA V5 are saved and exposed in SMARTEAM.
The impact analysis can be performed by displaying the links of a given object. Through the Tree 
Properties panel, SMARTEAM - Editor allows you to display/filter CATIA links in the Tree Browser.

You will retrieve in SMARTEAM all the link shown in the following panels.

From the Tree 
Properties.
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CATIA Drawings Links
You will learn how to analyze CATIA drawings in SMARTEAM.
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About CATIA Drawings Links

In CATIA, a drawing can be generated at any time from a Product or a Part. If one of them is 
modified, the drawing will be automatically updated thanks to the associative link.

In SMARTEAM, this mechanism is controlled by the Life Cycle mechanism. When you check out 
a CATDrawing, the system asks you if you want to replace the parts by the latest available if 
there is some.

A CATDrawing file contains a structure listing of all the sheets and views contained in the 
document. After saving in SMARTEAM, all sheets are displayed in the Documents Tree if the 
Visual Settings are defined for the Links (red links).

CATSheets available in the 
Specification tree in a
CATDrawing

CATSheets stored in SMARTEAM and 
displayed in Documents Tree
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CATIA Analysis Links
You will learn how to handle CATIA analysis links in SMARTEAM.
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About CATIA Analysis Links

SMARTEAM is able to save all CATIA Analysis links. These links are visible in the Documents 
tree or in the CATIA Links tab.  

In CATIA, the composition of a CATAnalysis file displayed in the Specification tree is defined by:

Links Manager folder

Finite Element folder

In the Links Manager folder, you can see:

A persistent CATPart or CATProduct link. A CATAnalysis file is always linked to a geometry.

An occasional CATAnalysisResults and CATAnalysisComputations links. These files are 
created when the user launches a computation.

In Finite Element folder, you can see all parameters applied to define the Structural Analysis 
such as Mesh, Forces, materials …

Documents Tree in SMARTEAM Specification Tree in CATIA V5 
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Breakdown Structure of CATIA Analysis File

Specification Tree of CATAnalysis file

The Specification tree for a CATIA Analysis file is detailed here below: 

Link to the part

Kind of Meshes and Properties 
that are applied to your part

Here you will find the restraints, 
loads etc… you have applied to 
your parts

Before computing an Analysis, 
you can apply sensors on 
predefined parameters 

Link to the Result file
Link to the Computation file
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CATIA Process Links
You will discover how to review CATIA Process links.
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About CATIA Process Links

When a CATProcess is initiated a CATPart or a CATProcess are automatically associated 
and an instance is created in the Product List folder in the Specification Tree in CATIA

NC CATProcess document and related linked documents (such as APT source, NC code, 
tool user representation, machine) can be automatically managed in SMARTEAM.

Documents Tree in SMARTEAM

Specification Tree in CATIA V5 
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Interoperability with Part Operation Panel (1/4)

Through the Part Operation panel, it’s possible to search a machine, a Part or a Product 
directly in SMARTEAM

Part Operation panel

Specification Tree in CATIA Process
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Interoperability with Part Operation Panel (2/4)

Part Operation Panel

In this example, you can see how to assign a machine from file selection option

SMARTEAM Open Document Panel 

The Machine (CATProduct) is instantiated 
into the Process and user can proceed 
further on.
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Interoperability with Part Operation Panel (3/4)

Part Operation Panel

In this example, you can see how to assign a CATIA Product or a Part to a Process. 

The CATIA Part to be instantiated into the Process is 
selected in the SMARTEAM Open Document Panel and 
validated OK.  
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Interoperability with Part Operation Panel (4/4)

If you cancel the search in SMARTEAM 
Open Document Panel, the Browse 
toolbar is displayed.

Browse toolbar

SMARTEAM Open Document Panel 

The Part is instantiated into the Process and user can 
proceed with including the Manufacturing Program
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Using Cache Management
You will learn how to open a large assembly in light representation.
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About a Cache System

Using a Cache System enables the user to manage heavy assemblies, by checking into the 
vault only the relevant documents. Therefore, it reduces the time required to load data.

Automatically during open, CATIA V5 creates a .cgr file in a specific folder. This created file is 
called CATIA Graphical Representation.

The cache system options are defined via the Cache 
Management tab in the CATIA V5 Tools/ Options panel

The CATIA Product is opened in visualization 
mode with no geometry loaded (observe the 
CATIA specification tree) 

A Part opened in visualization mode can be easily 
switched to design mode by a simple double click.
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CATIA Cache Management with SMARTEAM 

CATIA Cache management can be generated and managed by SMARTEAM for data saved 
under SMARTEAM.

The process is that CATIA copies the .cgr files from work or vault folder and puts in Cache 
folder with another name. It is a simple copy process not a creation process.

When the cache is active:

The representation is checked in the local cache and the possible cache releases.

If the representation is not found in the local cache or if the time stamp is not valid, the  
representation is extracted from the vault and copied back in the local cache.

If the representation is not found in the vault, the master document is loaded in CATIA V5 in 
order to be tessellated and updated in the local cache.

If a user checks in a CATPart file, the associated cgr
files will also go to the Check In vault. 

If the same or another user opens a CATProduct file 
referencing the CATPart files, the associated cgr will be 
used (in visualization mode) instead of the CATPart file.

SMARTEAM

Engineer BEngineer A

cgr filescgr files
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How to Use Cache Management

Select a product in 
Documents tree 

1

This function allows the user to manage the cache of data saved under SMARTEAM;
cgr files won’t be generated under CATIA cache folder

Select Design Mode option in the 
contextual menu on the selected 
part to modify geometry 

4
The geometric data is 
available in Specification 
Tree. All workbench 
commands are available if 
this mode is activated.

Select File Operation/Open to 
load the product Read Only

2
The product is opened in CATIA V5.The 
Visualization Mode uses documents in cgr
format. The geometry is not available.

3

5
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Mapping of Properties
You will see how to map properties between CATIA and SMARTEAM.
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About Mapping of Properties

The Mapping has the ability to connect properties made in CATIA V5 with attributes defined 
in SMARTEAM database.
For each mapped property, the mapping direction has to be defined: 

SMARTEAM =>CATIA : CATIA property values come from the SMARTEAM database
SMARTEAM <=CATIA: CATIA property values are written to the SMARTEAM database
CATIA ���� SMARTEAM : Both mapping directions are available

This task can only be performed by the administrator.
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Mapping Properties (1/2)

Select ‘SmarTeam’ menu > 
Tools > Property Management 

The defined mappings by class

The definition of the mapped attributes and properties, as well as the direction, is defined by 
the Administrator. However, any user can see the defined mapping. 
You can see which properties and attributes are mapped:
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Mapping Properties (2/2)

The CATIA Property 
being mapped

Name of CATIA Property

Corresponding 
SMARTEAM attribute

Indicates the direction in which 
the mapping can be made. 
Enable updating of Property or 
Enable updating of SMARTEAM. 

Some useful details like Properties and attributes which are mapped are easy to identify. 
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Updating Properties or Attributes

To update a value Command to be used

CATIA => SMARTEAM ‘SmarTeam’ / Save in SMARTEAM / 
Properties / Save in Database

SMARTEAM => CATIA ‘SmarTeam’ menu / Properties / Load from 
Database

When performing a modification in either CATIA or SMARTEAM, there are different ways to 
update the object or document which was modified.

Menu to update the attribute value

Load from Database or Save in Database are allowed only if the authorization has been granted by 
the administrator.
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How to Map Properties from CATIA to SMARTEAM (1/2)

You are going to define the mapping between a CATIA parameter and an attribute visible 
in a CATIA Part Profile Card - ‘Source’
In the CATIA document, the Property has to exist with the same name as the one entered 
in Property Management. 

Click on Formula icon 
in Knowledge toolbarIn CATIA Mapping Group 

Types panel under CATIA Part 
class, create a property

Click on New Parameter of 
type button and enter the 
description defined before in 
CATIA Mapping Group Types 

Confirm by 
clicking on “OK”

1
2

3

4
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How to Map Properties from CATIA to SMARTEAM (2/2)

In the CATIA document, the Property has to exist with the same name as the one 
entered in Property Management

The parameter appears in 
Specification Tree

Save from 
SMARTEAM toolbar

5

6

Menu to update value in 
SMARTEAM

7

Check the Profile card for 
CATIA Part, the value of 
attribute is updated

8
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How to Map Properties from SMARTEAM to CATIA

When you have the attribute mapping in place between CATIA V5 and SMARTEAM, you 
can change the attribute value in SMARTEAM and have it retrieved in CATIA V5.
Warning: the name of the mapped property has to correspond to the name entered by the 
administrator in the CATIA Mapping Group Types.

Change the value of 
the mapped attribute.

A component has been saved in the 
database. Update its Profile Card to 
add or modify information.

1 2

In the Profile card for the CATPart, 
confirm by clicking OK.3

4 To retrieve the information in the CATIA document,
if the document was not opened: File Operation > Edit; 
OR
if the document is already opened in session: 
SmarTeam > Properties > Load from Database.
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The SMARTEAM Administrator can map a drawing’s text with any of the CATIA Drawing 
attributes in the SMARTEAM database.

How to Manage Drawing's Data

4

A CATIA property is 
created inside the 
Drawing

In SmarTeam menu, select 
Properties – Map a Text ValueSelect a text in the drawing

The Map a Text Value panel 
displays. Select the adapted 
attribute define in CATIA 
Drawing class

2
1

3

4
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Lifecycle Operation
You will learn about the different Lifecycle Operation modes and ways to 
manage Assemblies. 



Student Notes:

SMARTEAM - CATIA Integration

Copyright DASSAULT SYSTEMES ��

����������	��

C
op

yr
ig

ht
 D

A
S

S
A

U
LT

 S
Y

S
TE

M
E

S

About Lifecycle Operations

Maintaining security and control over files is of utmost importance in an enterprise and 
SMARTEAM provides an electronic vault for this purpose. New versions of each file as it is 
revised are created and this helps in protection from unauthorized modifications.
The electronic vault ensures that only those persons with access permission may access a 
file, and that a file cannot be accessed by more than one person at a time.
By mirroring the physical process of product management, SMARTEAM - Editor uses the 
vaults, check in, check out, and release functions to manage the Lifecycle of revision 
manageable objects.

Lifecycle Rules Setup panel
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Managing an Assembly

Check Out Copy File

No Operation Release

New Release Obsolete

On a Check In or Release operation, the operation on the Product is automatically propagated to 
all of its children (administrator role).

Change operation by:
Clicking on the icon
Contextual menu on the icon

SMARTEAM provides for the Lifecycle Management with which you can perform any 
revision operation on an object and all its children simultaneously using the Propagate 
Operation option. This is essential to protect the integrity of an assembly together along 
with all of its children.

For example, if you have an Engine that has many children, you can perform any revision 
operation (such as Check In, Check Out, Release) on the Engine together with all its 
components simultaneously.

You can change the lifecycle operation on the children based on the choice executed on the 
root Product:
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Modifications on an Assembly

First method:
Check Out the Component
Perform the modification
Check it back In

Check Out the assembly: the latest version of the  
component is automatically selected
A « Revision Replacement Report » is generated

Second method:
Check Out the component
Perform the modification
On Check In operation, select ‘Action / 
Link Parents of Previous Revision’

The parent assembly points to this 
version of the component, without 
performing a Check Out of the assembly

When a component of an assembly is modified, you have two methods to reconcile the assembly 
with the latest revision of its components.
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How to Revise Associated Objects

As you revise your documents, SMARTEAM protects the relationship between 
Associated Objects.
When you perform a lifecycle operation on a document (such as Check In, Check Out  
and Release) you can display and manage the Associated Objects.

To display Associated Objects:
From advanced lifecycle window, right-click to display the contextual menu.
Select Associated Objects and choose the object type you wish to display.

The CATSheet and the CATDrawing are 
exposed in the tree

There is only the CATDrawing exposed 
in the tree

Each Associated Object is color-coded for easy recognition. 
The administrator can force the system to display a CATDrawing.
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How to Manage Associated Objects During Lifecycle (1/2)

Make ‘New Release’ of both sheet and part together.

How is a Part and its associated Drawing handled during Lifecycle operations?
If a CATIA Part and its associated Drawing and Sheet are released, you have two 
scenarios for modifications

1. Make ‘New Release’ of drawing and part
2. Modify the part, and synchronize the drawing later

In the tree, you have the choice to select the drawing or the sheet. This operation 
propagates on the two attached objects.

In ‘New Release’ panel, select Associated Objects > CATIA Links > All 
and choose ‘New Release’ for the sheet as well as for the part.

The Documents tree is updated

Part b.0

Sheet b.0

Part a

Sheet a

links1
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How to Manage Associated Objects During Lifecycle (2/2)

Modify the part, and synchronize the sheet after:
Part b.0

Sheet b.0

Part a

Sheet a

links

- New Release of the Part, and make Modifications.
- New Release of the Sheet. During New Release 

Operation, switch to the new release of the Part as 
Parent.

The report menu appears 
to show the reroute.

2
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Examples (1/2)

When releasing a Product all its children will also be released.

You can move a sub-product to the Obsolete Vault only if its parent is already obsolete.

You can make a revision operation on a Product and all its 
children simultaneously, using the Propagate Operation option 
in the intermediate panel by using ‘Life Cycle’ command.

Here you will see some examples which illustrate that the integrity of a product is protected 
during all lifecycle operations.

Release window

Obsolete window
Documents Tree window

Documents Tree window

‘Life Cycle’ command in 
SMARTEAM menu

‘Life Cycle’ command 
in SMARTEAM menu
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Examples (2/2)

Here you will see some examples which illustrate that the integrity of a product is protected 
during all life cycle operations.

You can perform a revision operation on a product and just copy its children to the desktop
On a Product, select Check Out
In the Check Out panel, display a Top Down Tree of the Assembly
The icons on left side indicate which objects will be checked out or copied

You can check out a child independently, and leave the parent product in the vault
On a part, select Check Out.

Check Out window

Documents Tree window


